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AÇIKLAMALAR

KODU 213GIM298

ALAN Grafik ve Fotoğraf

DAL/MESLEK Grafik Oparatörü

MODÜLÜN ADI Görüntü Düzenleme

MODÜLÜN TANIMI
Gerekli ortam sağlandığında bilgisayarda görüntü
düzenleme becerisinin kazandırıldığı öğrenme materyalidir.

SÜRE 40/32

ÖNKOŞUL Ön koşulu yoktur.

YETERLİK Bilgisayarda görüntü düzenlemek

MODÜLÜN AMACI

Genel Amaç

Gerekli ortam sağlandığında bilgisayarda görüntü
düzenleme yapabileceksiniz.

Amaçlar

Bu faaliyette verilecek bilgiler doğrultusunda, uygun ortam
sağlandığında;

1. Bitmap resmin boyut ayarlarını yapabileceksiniz.

2. Bitmap resmi rötüş yapabileceksiniz.

3. Bitmap resmin renk ayarlarını yapabileceksiniz.

EĞİTİM ÖĞRETİM
ORTAMLARI VE
DONANIMLARI

Ortam: Aydınlık ve pencereleri sola bakan geniş sanatsal
mimariye sahip sınıflar.

Donanım: Bilgisayar, tarayıcı, tazıcı, görüntü(fotoğraf)
arşivi cdleri, internet,

ÖLÇME VE
DEĞERLENDİRME

Modülün içinde yer alan her faaliyetten sonra, verilen
ölçme araçlarıyla kazandığınız bilgileri ölçerek kendi
kendinizi değerlendireceksiniz.

Öğretmen, modül sonunda size ölçme aracı ( test, çoktan
seçmeli, doğru yanlış vb.) uygulayarak modül uygulamaları
ile kazandığınız bilgileri ölçerek değerlendirecektir.

AÇIKLAMALAR
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GİRİŞ

Sevgili Öğrenci,

Basım ve yayın organları başta olmak üzere görüntüler üzerinde farklı uygulamalar
yapılma ihtiyacına gerek duyulmaktadır. Grafik, fotoğraf ya da resimler üzerinde dijital
ortamda renk ayarları, montaj, düzeltme, birleştirme gibi değişiklikler yapabileciğimiz
programları öğrenmemiz gerekmektedir.

Hazırlanan bu modülde görüntü düzenleme programı çalışma alanı, temel fotoğraf
rötuşlama işlemleri ve renk uygulamalarını ele alacağız.

Modülü başarı ile tamamladığınızda, görüntü düzenleme programı ile ilgili yeterli
bilgiye sahip olacak ve görüntüler üzerinde çeşitli uygulamalar yapabilme becerisine
kavuşacaksınız. Görüntü düzenleme programın öğrendikten sonra tasarımlarınız insanların
dikkatini çekicek türden estetik ve ilgi çekici olacaktır.

GİRİŞ
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ÖĞRENME FAALİYETİ–1

Bu faaliyette verilecek bilgiler doğrultusunda, uygun ortam sağlandığında, gerekli araç
gereçler ile bitmap resmin boyut ayarlarını yapabileceksiniz.

 Piksel tabanlı programları, görüntü düzenleme ile ilgili basılı görsel kaynakları
ve internet sitelerini inceleyebilirsiniz.

1. GÖRÜNTÜ DÜZENLEME PROGRAMI
ÇALIŞMA ALANI

1.1. Piksel Tabanlı Programı başlatmak ve bir dosyayı açmak

1.1.1. Piksel

Tüm dijital ve taranmış görüntülerin temel yapı taşı olan noktacıklara "piksel" denir.
Görüntü çok sayıda küçük piksellerden oluşmuş ise, baskı aldığınızda elinize net ve keskin
hatlı bir fotoğraf, görüntü az sayıda ve büyük piksellerden oluşmuş ise, yeterince net
olmayan ve bulanık hatlı bir fotoğraf elde ederiz. Kısacası, piksel sayısı arttıkça baskı
kalitesi de yükselmektedir.

Resim 1.1: Piksel görüntüsü

ÖĞRENME FAALİYETİ–1

ARAŞTIRMA

AMAÇ
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1.1.2. Piksel tabanlı programın çalışma alanı
A

B

C

D
E

Resim1.2: Piksel tabanlı programın çalışma alanı görüntüsü

A. Uygulama çubuğu
B. Program menü çubuğu
C. Seçenekler Çubuğu
D. Araçlar paneli
E. Kayar ve değişken paneller

1.1.3. Piksel tabanlı programda dosya açmak

Resim 1.3: Piksel tabanlı programda dosya açma görüntüsü

Programın menü çubuğunda “File” menüsüne tıkladığınızda açılan alt başlıklardaki
“open” yeni bir dosya açmanızı sağlar. Sonrasında karşınıza çıkan pencereden dosyanıza
ulaşır ve kolaylıkla açabilirsiniz.
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1.2. Araçları Kullanmak

Resim 1.4: Araçlar paneli

Araçlar paneli (çalışma alanının solundaki uzun ince
panel) görüntü üzerinde farklı çalışmalar yapmanızı
sağlar.

Resim 1.5: Move Tool

Move Tool: Seçim ve taşıma aracıdır. Klavyeden “V”
tuşuyla da seçilir. İmleci araçlar panelinin üzerine getirin
ve “move tool” üzerine tıklayarak aracı seçin.

Resim 1.6: Marquee Tool

Marquee Tool: İşaretleme ve seçili alan oluşturma
aracıdır. Klavyeden “M” tuşuyla da seçilir. ,
Bir tools panelinin sağ alt kısmında görüntülenen küçük
üçgen, o aracın arkasında gizli başka araçların
bulunduğunu gösterir. İmleci Marguee tools panelinin
sağ altındaki üçgene getirerek basılı tuttuğunuzda
dikdörtgen ve oval işaretleme ile yatay-dikey yönde
çizgisel işaretleme seçeneklerine ulaşabilirsiniz.



5

1.3. Araç işlemlerini klavye kombinasyonlarıyla birlikte kullanmak

Araçların çoğu belirli kısıtlamalarla kullanılabilir. Mause(fare) ile tıklanılarak seçilen
araç, hareket ettirilirken belirli klavye tuşuna basılı tutulur ve etkinleştirilir. Böylece istenilen
kısıtlama gerçekleştirilir. Örneğin elips değil de daire çizmek istiyorsak “eliptical marqueq
tool” seçtiğimizde klavyeden “shift” tuşuna basılı olarak işlem yaptığımızda şeklin daire
olduğunu görürüz. Ayrıca shift tuşu ile birlikte alt tuşunu da basılı tutarsak merkezden dışarı
doğru çizim yapabiliriz.

Resim 1.7: Elliptical Marquee Tool

 Araçlar panelinden “Elliptical Marquee Tool” seçin

Resim 1.8: Elliptical Marquee Tool ile seçili alan oluşturma

 İmleci düyanın ortasına getirin

 Alt+Shift tuşlarını birlikte basılı tutun ve imleci dünyanın merkezinden mause
basılı şekilde dışarıya doğru sürükleyin

 Daha sonra mause ardından klavyede ki basılı tuşları bırakın.
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1.4. Seçili bir alanda değişiklik yapmak

Ekrana çağırdığınız resim üzerinde seçim yapmadığınız sürece yapacağınız işlemler
resmin tamamına uygulanır. Özellikle resmin üzerinde bir bölgeye uygulama yapmak
istiyorsanız o bölgeyi seçili alan haline getirmelisiniz. Eğer seçili alanın dışına uygulama
yapmak istiyorsanız program menu çubunda yer alan “Select/Inverse” dediğinizde seçili
alanı tersine çevirerek o bölgeye uygulama yapabilirsiniz.

Ekrana getirdiğimiz resim üzerinde yer alan kapı önündeki kediyi ön plana çıkartarak
vurgulamak istiyoruz.

 Araçlar panelinde elliptical marquee tool seçin

 Klavyeden Shift tuşuna basılı olarak kediyi içine alıcak daire çizin

Resim 1.9: Seçili alan oluşturma

 Program menu çubunda yer alan “Select/Inverse” e tıklayın

Resim 1.9: Seçili alan dışında kalan bölümün seçilmesi
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 Program menu çubunda yer alan “Filter/Blur/Gaussion Blur” e tıklayın.

Resim 1.10: Filitreler menüsü

 Karşınıza çıkan Gaussian Blur panelinde Radius değerin 25 yapın ve Ok basın

Resim 1.11: Gaussian Blur paneli
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Resim 1.12: Seçili alan dışına Gaussian Blur uygulanması

 İmleci resim dışında herhangi bir yere tıklayın ve yaptığınız değişiklikleri
kaydetmek için File/Save komutuna tıklayarak işleminizi tamamlayabilirsiniz.

1.5. Gezinti paleti ile görüntüyü büyütmek ve kaydırma yapmak

Navigator (Gezinti) paletini kullanmak, büyütme oranında değişiklik yapmanın diğer
bir hızlı yöntemidir. Özellikle büyütme oranının tam değeri sizin için önemli değilse bu
paleti kullanabilirsiniz. Bu, aynı zamanda bir resmin farklı bölümlerini görüntülemek üzere
kaydırma yapmak için de kullanabileceğiniz mükemmel bir yöntemdir.

Programın menü çubuğundan Window/Navigator e tıkladığınızda pencere ekrana
gelir.

Resim 1.13: Navigator (Gezinti) paleti
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Navigator penceresinin alt kısmındaki ibreyi sağa sola doğru hareket ettirildiğinde
görüntü büyür ve küçülür, ayrıca yine navigatör penceresi üzerinde ortaya çıkan kırmızı
çerceveli alanı kaydırıldığında sadece o bölge zoomlanır.

Resim 1.13: Navigator (Gezinti) paleti uygulamaları

1.6. Araç seçenekleri çubuğunu ve diğer panelleri kullanmak

1.6.1. Seçenekler Çubuğu

Araç seçenekleri çubuğu programın üst kısmında yer alan, uygulamalarımızda bize
yardımcı olmakla birlikte tamamlayan bir çubuktur.

Resim 1.14: Araç seçenekler çubuğu

Araçlar paneli ile seçenekler çubuğu birbirine bağlantılıdır. Araçlar çubuğundan bir
tool seçtiğinizde o tool ile ilgili seçenekleri gösteren düğmeler ve menüler “seçenekler
çubuğunda” belirecektir.

 Program çubuğundan File/Open diyerek düzenlemek yapmak istediğiniz bir
resim çağırın.

 Araçlar çubuğundan “Crop Tool” u seçtiğinizde seçenekler çubuğunda ilgili
seçenekleri gösteren düğmeler ve menüler belirecektir.

Resim 1.15: Araçlar paneli ile seçenekler çubuğu birbirine bağlantılıdır
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 Resmi belirlediğiniz ölçüleri ve çözünürlük değerini giriniz (Width:7, Height:5,
Rosolution:300 )

Resim 1.16: Araç seçenekler çubuğu

 Crop toolu resmin üzerinde sürüklediğinizde oluşturduğunuz alan W:7 H:5
oranı koruyacak aynı zamanda ister büyük ister küçük alan oluşturun elde
ettiğiniz alanın ölçüleri seçenekler çubuğunda baştan belirlediğiniz ölçüler ve
çözünürlük olacaktır.

5cm

7cm

Resim 1.17: Araç seçenekler çubuğu ile seçim

1.6.2. Diğer Paneller

Araçlar paneli ile seçenekler çubuğunun birbirine bağlantılı olduğunu belirtmiştik.
Bazı işlemlerde de panellere ihtiyaç duyulmaktadır. Araçlar çubuğundan bir tool seçtiğinizde
o tool ile ilgili yardımcı paneller bulunmaktadır. Bu panellere program menü çubuğunda
Window menüsünden ulaşacağımız gibi mause sağ tuşuyla tıklayarak da ekrana çıkmasını
sağlayabiliriz.

Biraz önce kestiğimiz resimde sol taraftaki gezegen görüntülerini silmek istediğimizde
panellerden faydalanmamız gerekir.
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 Araçlar panelinden Eyedropper Tool u seçin.

Resim 1.18: Eyedropper Tool

 Resmin üzerinde silmek istediğiniz yere yakın bir alandan “Eyedropper Tool”
ile renk seçin.

Resim 1.19: Eyedropper Tool ile seçim

 Araçlar panelinin en altındaki “color” da seçilen rengin üstteki renk kutusuna
geçtiğini göreceksiniz

Resim 1.20: Color
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 Ardından bu sefer araçlar panelinden “Brush Tool” u seçin.

Resim 1.21: Brush Tool

 -Seçtikten sonra mause sağ tıkladığınızda Bursh paneli ekrana gelecektir. Bu
panele seçenekler çubuğundan da rahatlıkla ulaşabiliriz

mause sağ tıklayarak çıkan panel

Resim 1.22: Brush Tool paneli

 Bu panelden brush için uygun ucu seçin. Daha sonra silmek istediğiniz bölgede
imleci sürükleyin.

Resim 1.23: Brush Tool kullanımı
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1.7. Piksel tabanlı Programda işlemleri geri almak

Piksel tabanlı programda tek bir işlemi geri almak için “Edit menüsünden Undo”
komutuyla yada klavyeden “Ctrl”ile“z” tuşuna birlikte basılı tutarak gerçekleştirebilirsiniz.

Resim 1.24: Edit menüsünden geri almak

Birden fazla komutu geri almak için ise “Cntr+Alt+z” klavye kombinasyonu veya
“History” (geçmiş) paleti kullanılır. Program menü çubuğundan Window/History e
tıkladığımızda karşımıza history paneli çıkar. Burada yapılan işlemler sırasıyla
görülmektedir. Hangi işlem öncesine dönülmek isteniyorsa o işlemin üzerine tıklanarak
kolaylıkla geri gidilir.

Resim 1.25: Histori (Geçmiş) paneli ile geri almak
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1.8. Araç kutusuna genel bakış

Move (V)

Rectangular Marguee (M)

Lasso (L)

Quick Selection (W)

Crop (C)

Eyedropper (i)

Spot Healing Brush (J)

Brush (B)

Clone Stamp (S)

History Brush (Y)

Eraser (E)

Gradient (G)

Blur (R)

Dodge (O)

Pen (P)

Type (T)

Path Selection (A)

Rectangle (U)

3D Rotate (K)

3D Orbit (N)

Hand (H)

Zoom (Z)

 Move (Taşıma) aracı: Seçimleri,
katmanları ve klavuzları taşır.

 Rectangular (işaretleme) araçları:
Dikdörtgen, elips, tek satır veya tek
sütün şeklinde seçimler yapar.

 Lasso (Taşıma) araçları: Serbest
biçimde, çok köşeli (düz kenarlı) ve
manyetik (yapışmalı) seçimler yapar.

 Quick Selection (Hızlı Seçim)
araçları: Özellikle birbirine yakın renk
tonlarını hızlı bir şekilde seçim
yapmanızı sağlar.

Resim 1.26: Araç kutusu ve araçlar
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Crop (Kırpma) araçları: Resimleri keser.  Clone Stamp (Kolonlama damgası)
araçları: Resimlerden örneklenen
alanın görüntüsüyle boyama yapar.

 Eyedropper (Damlalık) araçları:
Resimdeki renk değerlerini örnekler ve
renk kutucuğuna taşır.

 History Brush (Geçmiş fırçası)
araçları: Yapılmış olan boyamalrı geri
alır.

 Spot healling brush (Düzeltme
fırçası) araçları: Resimlerdeki hataları
ve kusurları hızlı bir şekilde yok eder.

 Eraser (Silgi) araçları: Pikselleri siler.

 Brush (Fırça) araçları: Fırça
darbeleriyle boyama yapar



 Gradient (Degrade) araçları: Seçilen
alanda renkler arasında farklı karışım
ve seçimler yapar.

Resim 1.27: Araç kutusu araçları
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 Clone Stamp (Kolonlama damgası)
araçları: Resimlerden örneklenen
alanın görüntüsüyle boyama yapar.

 Blur (Yumuşatma) araçları: Sert
kenarları yumuşatır.

 History Brush (Geçmiş fırçası)
araçları: Yapılmış olan boyamalrı geri
alır.

 Dodge (ton açma) araçları:
Resimlerdeki belirli alanların rengini
açar.

 Eraser (Silgi) araçları: Pikselleri siler.  Pen (Kalem) araçları: Düzgün kenarlı
yollar çizer

 Gradient (Degrade) araçları: Seçilen
alanda renkler arasında farklı karışım
ve seçimler yapar.

 Type (Yazım) araçları: Resimlerde
yazı oluşturmak için kullanılır.

Resim 1.28: Araç kutusu araçları
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 Path Selektion (Yol seçim) araçları:
Bağlantı noktalarını, yön çizgilerini ve
yön noktolarını gösteren şekil ve parça
seçimleri yapar.

 Rectangle (Otomatik şekil) araçları:
Normal yada şekil katmanında şekiller
ve çizgiler çizmek için kullanılır.

 Hand (El) araçları: Resmi kendi
penceresinin içinde sağa sola ve yukarı
aşağı hareket ettirir.

 Zoom (Yakınlaştırma) aracı: Resmin
görüntüsünü büyütüp küçültür.

Resim 1.29: Araç kutusu araçları

1.9. Actions Uygulamaları

Actions uygulamaları ile programda bir resme veya yazıya uyguladığımız işlemleri
(efekt, boyutlandırma, ışıklandırma) kaydedebilir ve başka resim ve yazılar üzerinde bu
işlemleri kolay bir şekilde uygulayabilirsiniz. Bu işlemler özellikle çoklu çalışmalarda büyük
kolaylık sağlamaktadır

Actions paneli için Alt+F9 ya da program menü çubuğundan “Window/Actions a
tıklanır.

Resim 1.30: Actions panelinin açılması
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Actions paneli tanıyacak olursak;

1 2 3 4 5 6

Resim 1.31: Actions paneli

 1-Action oluşturma işlemini sonlandıracağımız buton.

 2-Action oluşturmak için tıklayacağımız buton.

 3-Action uygulamasını kayıt için başlatma (play) buton

 4-Create New Set Action klasörü açmak için

 5-Create New Action Yeni action oluşturmak için buton.

 6-Delete

Actions uygulaması için ilk olarak;
(4)Create new set butonuna tıklayarak yeni klasör oluşturalım.

(5)Create New Action butonuna tıklandığında New Action penceresi karşımıza çıkar,
bu pencerede name kısmına isim girdikten sonra “OK” butonuna tıkladığımızda artık
yapacağımız işlemler kayıt edilecektir.

Resim 1.32: Actions uygulaması
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Program menü çubuğundan File/Open diyerek ekrana bir resim çağıralım

Resim 1.33: Bilgisayarınızda kayıtlı herhangi bir resim

Resmin boyutlarını küçültmek için program menü çubuğundan Image/Image size
diyerek karşımıza çıkan pencereden genişlik(width) ölçüsünü 15 cm yapıp ok tuşuna
basalım.

Resim 1.34: Resmin boyutlandırılması
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Daha sonra program menü çubuğundan Filter/Texture/Mosaic Tiles diyerek karşımıza
çıkan pencerede istediğimiz ayarları yapıp ok tuşuna basalım.

Resim 1.35: Resme filtre eklenmesi

Son olarak Action penceresinde Action penceresinden (1)stop butonuna tıklayalım,
resmi kapatalım.

1

Resim 1.36: Actions paneli
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3

Resim 1.37: Actions uygulaması

Yeni bir resim üzerinde kayıt ettiğimiz action play butonuna tıklayarak yeni aldığımız
resim üzerine kayıt ettiğimiz işlemlerin uygulandığını görebiliriz. Benzer birçok uygulama
yapabilirsiniz.
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UYGULAMA FAALİYETİ

Aşağıdaki işlemleri tamamladığınızda resim işleme programında fotoğraf
üzerinde istenilen değişiklikleri yapmış olacaksınız.

Kullanılacak araç ve gereçler
 Bilgisayar

 Resim işleme programı

 Görseller

İşlem Basamakları Öneriler

Piksel tabanlı programda görsel açınız. Atölye önlüğünüzü giymeyi unutmayınız.

Çözünürlüğünü ayarlayınız. Görseli kullanacağınız alanı dikkate alınız.

İstenilen boyuta getiriniz. Ölçülere dikkat ediniz.

Görselin istenmeyen bölümlerini
silme/kesme işlemini yapınız.

Dikkatli olunuz.

Kayıt ediniz.
Uygulama sırasında sorun ile karşılaşırsanız
öğretmeninizden yardım alınız.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME
Bu faaliyet sonunda kazandıklarınızı aşağıdaki soruları cevaplandırarak

ölçünüz.

ÖLÇME SORULARI

Aşağıdaki sorular boşluk doldurmalı olarak hazırlanmıştır, boş bırakılan
yerlere en uygun cevabı yazınız.

1. Tüm dijital ve taranmış görüntülerin temel yapı taşı olan noktacıklara ……….denir.
2. …………Tool: Seçim ve taşıma aracıdır. Klavyeden …. tuşuyla da seçilir.
3. …………Tool: İşaretleme ve seçili alan oluşturma aracıdır. Klavyeden ……..

tuşuyla da seçilir. ,
4. ………/…….dediğinizde seçili alanı tersine çevirerek o bölgeye uygulama

yapabilirsiniz.
5. ………………. paletini kullanmak, büyütme oranında değişiklik yapmanın diğer bir

hızlı yöntemidir.
6. Birden fazla komutu geri almak için ise ………. paleti kullanılır.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız ve doğru cevap sayınızı
belirleyerek kendinizi değerlendiriniz. Yanlış cevapladığınız sorularla ilgili öğrenme
faaliyetlerini tekrarlayınız.

ÖLÇME VE DEĞERLENDİRME
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UYGULAMALI TEST

Uygulama faaliyetindeki işlemi yapınız ve çalışmanızı aşağıdaki
değerlendirme ölçeğine göre değerlendiriniz.

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız
becerileri evet ve hayır kutucuklarına (X) işareti koyarak kontrol ediniz.

Değerlendirme Ölçütleri Evet
Ha

yır

1. Bilgilerinizi gözden geçirdiniz mi?

2. Malzemeyi temin ettiniz mi?

3. Fotoğrafı resim işleme programında açtınız mı?

4. Çözünürlüğünü ayarladınız mı?

5. İstenilen boyuta getirdiniz mi?

6. Görselin istenmeyen bölümlerini silme/kesme
işlemini yaptınız mı?

7. Kayıt ettiniz mi?

8. Zamanı verimli kullanmaya dikkat ettiniz mi?

9. Çalışmanızdan memnun kaldınız mı?

DEĞERLENDİRME

Uygulama faaliyetinde kazandığınız davranışlarda işaretlediğiniz evetler
kazandığınız becerileri ortaya koyuyor. Hayırlarınız için ilgili faaliyetleri
tekrarlayınız

Tamamı evet ise diğer öğrenme faaliyetine geçiniz.
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ÖĞRENME FAALİYETİ–2

Bu faaliyette verilecek bilgiler doğrultusunda, uygun ortam sağlandığında, piksel
tabanlı programda resmi rötüşlayabileceksiniz.

 Piksel tabanlı programlar ve görüntü düzenleme ile ilgili basılı görsel kaynakları
ve internet sitelerini inceleyebilirsiniz.

2. TEMEL FOTOĞRAF RÖTUŞLAMA
İŞLEMLERİ

2.1. Rötuşlama Stratejisi

Fotoğraf üzerinde rötuşlama işlemi belirli aşamalarla gerçekleştirilir.
 Fotoğraf makinesinden resmi bilgisayara aktarmak ya da resmi taramak

(Resimden bir tane çoğaltarak mutlaka bir kopyası üzerinden çalışın)

 Resmin çözünürlüğünü kontrol etmek ve kullanım şekline uygun hale getirmek

 Resmi gerektiğinde keserek(kırparak) boyutunu ve yönünü ayarlamak

 Resim üzerinde kusurları (toz veya lekeler gibi)

 Resmin renk kontrastını ve ton aralığını ayarlamak

 Renk dengesizliğini gidermek

 Resmin genel görüntüsünü netleştirmek

2.2. Bir resmi doğrultmak ve kırpmak

Fotoğrafı kırpmak ve ölçeklemek için “Crop” aracını kullanarak, fotoğrafı istenilen
alan için sığacak şekilde ayarlayabilirsiniz.

AMAÇ

ARAŞTIRMA

ÖĞRENME FAALİYETİ–2
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 Araçlar panelinden crop aracını seçin

Resim 2.1: Araçlar panelinde Crop (Kırpma) aracı

 Seçenekler çubuğunda (çalışma alanının üstünde yer alır) resmin boyutlarını
With(genişlik)-Heigh(yükseklik) bölümlerine cm olarak girin.( Örneğin 5cm x
3,5cm)

 Resmin etrafına kırpma çerçevesi çizin. Çerçevenin alanı ne olursa olsun hedef
olarak belirtilen değerlerin oranını (Örneğin 5cm x 3,5cm) korur.

Resim 2.2: Seçenekler çubuğu ve kırpma çerçevesi

 Resim penceresinde, imleci kıpma çerçevesinin dışına taşıyın ve imlecin çift
yönlü kavisli ok simgesine dönüşmesini sağlayın. Resimdeki pencere
çerçevesinin kenarlarıyla paralel hale gelene kadar çerçeveyi sürükleyerek
döndürün

Resim 2.3: Resmin kırpılması
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 İmleci kırpma çerçevesinin içine yerleştirin ve çerçeveyi, görsel açıdan tatmin
edici bir sonuç oluşturmak üzere resmin görüntülemek istediğiniz kısmını
kapsayana kadar sürükleyin. Çerçevenin büyüklüğünü ayarlamanız gerekirse,
köşe tutamaçlarından birini tutup sürükleyin.

 Enter tuşuna basın. Resim düzeltilmiş ve verilen ölçülerle boyutlandırılmış
olarak kırpılacaktır.

 File – Save komutunu seçerek çalışmanızı kaydedin

Resim 2.4: Çalışmanın kaydedilmesi

2.3. Otomatik ayarlar yapmak

Piksel tabanlı program, resimleri düzeltmeyi sağlayan otomatik özelliklere sahiptir.

Daha önce kesme ve ölçülendirme işlemi yapılan resim kayıt edildikten sonra
kopyasını oluşturun. Resmin bir kopyasını oluşturmak için File menüsünden Save As
komutunu seçin ve resim dosyasına yeniden adlandırın
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Image menüsünden “Auto Color” komutunu seçin. Renk dengesizliğini otomatik
olarak giderecektir

Resim 2.5: Renk dengesizliğinin otomatik olarak giderilmesi

Resim üzerinde gölge ve vurguları daha da netleştirmek istediğinizde Image
menüsünden “Adjustments Shadows/ Higlights komutunu” seçin.

Resim 2.6: Shadows/Higlights panelinin açılması
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Çıkan pencere üzerinde Shadows ve Highlights sürgülerini resim düzgün bir şekilde
görününceye kadar kaydırın.

Resim 2.7: Shadows/Higlights paneli

Ok düğmesine tıklayarak iletişim kutusnu kapatın ve resmi kaydedin

Resmin kontras ve ton ayarlarını da yapmak için aynı Image menüsünden Auto
Contrast yada Auto Tone komutlarını tıklayarak yapabilirsiniz.

2.4. Bir resimdeki renkleri değiştirmek

Bir resimdeki belirli yerlerdeki renkleri değiştirmenin farklı yöntemleri vardır.
“Replace Color” komutunu kullanarak renk değişikliği rahatlıkla yapılır. Programın menü
çubuğundan Image>Adjustment>Replace Color seçeneğini tıklayın.

Resim 2.8: Replace Color penceresinin açılması
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Karşınıza çıkan Replace Color penceresinde, Selection kısmında kutucuğu bulunan
“Localized Color Clusters” aracına tıklayın.

Resim 2.9: Replace Color penceresi

Eyedropper simgesiyle renk bölgesi seçin, yakın renkleri de ilave etmek için
+Eyedropper ı kullanın.

Eyedropper Seçilen
bölgenin rengi

Seçilen bölgenin
yerine yerleştirilecek

renk

Resim 2.10: Replace Color uygulaması
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Fuzziness değerini değiştirerek seçtiğiniz renge yakın olan diğer renkleri; Hue,
Saturation ve Lightness barları ile seçtiğiniz rengin yerine yerleştirilecek farklı renkleri
seçebilirsiniz. Renkleri belirledikten sonra Ok butonuna tıklayın.

Resim 2.11: Replace Color uygulanmış resim

Böylece seçilen mavi tonların yerine farklı bir renkle değişiklik yapılır.

2.5. Soldurma aracıyla aydınlığı ayarlamak

Piksel tabanlı programda resmin aydınlığını ayarlamak için araçlar panelinden Dodge
aracı kullanılır

 Araçlar panelinden Dodge aracını seçin

Resim 2.12: Dodge aracının seçilmesi

 Default Foreground and Background Colors düğmesine tıklayarak siyahı ön
plan rengi beyazı da arka plan rengi plan yapın

Resim 2.13: Default Foreground and Background Colors düğmesi
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 Seçenekler çubuğundan Brush açılır panelinden 40 piksellik yumuşak kenarlı
fırça tanımlayın

Resim 2.14: Brush açılır penceresi

 Range menüsünden Shadows’u(gölge) seçin

Resim 2.15: Range menüsü

 Exposure (pozlama) değerini %100 olarak ayarlayın

 Yatay veya dikey fırça darbeleriyle resim üzerinde istenilen yerlerde aydınlığı
ayarlayabilirsiniz

Resim 2.16: Aydınlığın ayarlanması

2.6. Sponge (Sünger) aracıyla duygunluğu ayarlamak

Bir rengin doygunluğunu değiştirdiğinizde, aslında o rengin gücünü ya da saflığını
ayarlamış olursunuz
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 Dodge aracının arkasında gizlenen Sponge aracını seçin.

Resim 2.16: Sponge (Sünger) aracının seçilmesi

 Seçenekler çubuğunda Brush açılır panelinden 95 piksellik yumuşak kenarlı
tüylü bir fırça seçin

Resim 2.17: Brush açılır penceresi

 Mode menüsünden Saturate’i (Doygunluk) seçin

Resim 2.17: Mode menüsü

 Flow (akış) alanına %35 değerini girin. Flow değeri, doygunluk efektinin
yoğunluğunu ayarlar.

 Sponge aracını resmin üzerinde ileri geri hareket ettirerek bu öğenin
doygunluğunu arttırın

Resim 2.18: Doygunluğu arttırılmış resim
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2.7. Klonlama damga aracıyla belirli alanları onarmak

Klonlama damga aracı ile resmin belirli bir alanındaki pikselleri, aynı resmin bir başka
alanındaki piksellerle yer değiştirerek onarma işlemi yapılır. Bu aracı kullanarak resimdeki
istenmeyen görüntüler silinir ayrıca eksik alanlar da doldurulur.

 Araçlar panelinden Clone Stamp aracını seçin

Resim 2.19: Clone Stamp (Klonlama damga) aracı

 Seçenekler çubuğunda Brush menüsünden yumuşak kenarlı bir fırça seçin. (45
gibi)

Resim 2.20: Seçenekler çubuğunda Brush menüsü

 Seçenekler çubuğunda Opacity değerini %100 yaparak Aligned seçeneğini
işaretleyin

Resim 2.21: Seçenekler çubuğunda Opacity değeri

 Alt tuşuna basılı olarak taşımak istediğiniz yere yakın bölgeden piksel görüntü
alın. Alt tuşunu bırakarak onarmak istediğiniz bölgeye mausenuzu
getirdiğinizde piksellerin taşındığını göreceksiniz.

Alt tuşuyla
pikselleri alınan

bölge

Taşınan bölge

Resim 2.22: Klonlama damga aracıyla onarmak
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 Bu işlemi tekrarlayarak onarma işlemini gerçekleştirebilirsiniz.

Resim 2.23: Klonlama damga aracıyla onarmak

2.8. Nokta düzeltme fırçası aracını kullanmak

Resimdeki bazı karanlık noktaları temizlemek için kullanılır. Bu işlemi Clone Stamp
aracıyla da yapılabilir ancak başka bir teknik de kullanılmaktadır. Spot Healing Brush aracı
fotoğraflardaki hataları ve diğer kusurları hızlı bir şekilde ortadan kaldırır. Hataları
rötuşlamak için mükemmel bir araçtır.

 Araçlar panelinden Spot Healing Brush aracını seçin.

Resim 2.24: Spot Healing Brush (Nokta düzeltme fırçası)

 Seçenekler çubuğunda Brush açılır panelini açın ve çapı 35 olan %100 lük fırça
tanımlayın.

Resim 2.25: Seçenekler çubuğunda Brush açılır paneli
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 Resim üzerinde Spot Healing Brush aracını düzeltilmek istenen bölge üzerine
sağdan sola sürükleyin. İşlemi uygularken fırça darbesi ilk başta siyah görünür,
fakat mause düğmesi bırakıldığında boyanan alan düzelir.

Resim 2.26: Spot Healing Brush (Nokta düzeltme fırçası) aracının kullanımı

2.9. Düzeltme fırçası ve yama araçlarını kullanmak

2.9.1. Düzeltme Fırçası

Düzeltme Fırçası aracı, çevredeki görüntü içinde gözden kaybolmalarını sağlayarak
kusurların giderilmesine yardımcı olur. Klonlama aracı gibi Düzeltme Fırçası aracını da,
görüntü veya desenden alınmış piksellerle boyamak için kullanılır. Bununla birlikte,
Düzeltme Fırçası aracı örneklenen piksellerin dokusunu, aydınlatmasını, saydamlığını ve
gölgelemesini de düzeltilmekte olan piksellerle eşleştirir.

Örneklenmiş pikseller ve düzeltilen görüntü

 Araç çubuğundan Healing Brush (Düzeltme Fırçası) aracını seçin.

Resim 2.27: Healing Brush (Düzeltme Fırçası) aracı
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 Seçenekler çubuğunda fırça örneğini tıklatın ve açılan palette fırça seçeneklerini
ayarlayın. Örneğin: Size:10, Hardness:100, Spacing%25

Resim 2.28: Seçenekler çubuğunda fırça ayarları

 Kopyalanacak noktayı ayarlamak için Healing Brush Toll’u görüntünün bir
alanına konumlandırın ve Alt (Windows) tuşunu basılı tutarak tıklatın.

 Düzeltmek istediğiniz görüntünün içinde sürükleyin. Mause düğmesini her
bıraktığınızda, örneklenen pikseller varolan piksellerle karıştırılır.

Resim 2.29: Healing Brush (Düzeltme Fırçası) uygulanmış resim
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2.9.2. Yama araçları

Yama aracı, seçili bir alanı başka bir alana ya da desene ait piksellerle onarmanızı
sağlar. Düzeltme Fırçası aracı gibi Yama aracı da kopyalanan piksellerin dokusunu, ışığını
ve gölgelendirmesini kaynak piksellerle eşleştirir. Yama aracını ayrıca görüntünün yalıtılmış
alanlarını klonlamak için de kullanabilirsiniz.

 Araç çubuğundan yama aracı Patch Tool’u seçin.

Resim 2.30: Patch Tool (Yama aracı)

 Seçenek çubuğundan “Source” işaretleyin.

Resim 2.31: Patch Tool (Yama aracı) Seçenekler çubuğu

 Patch Tool’u resim üzerinde pikselleri değiştirmek için seçtiğiniz bölgeyi
etrafından çizerek seçili hala getirin. Ortasından tutup sağa, sola, yukarı aşağı
kaydırın. Böylece o alana diğer dokuları transfer edebilirsiniz. Bütün bir alanı
bir kerede yapamıyorsanız, parça parça seçimler yaparak dada düzgün dokular
transfer edebilirsiniz.

Resim 2.32: Patch Tool (Yama aracı) uygulaması

 Görüntüdeki piksellerle onarırken en iyi sonuçları almak için küçük bir alan
seçin.
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2.10. Anlık görüntüler ve geçmişi gizle paletinin durumları

Tasarım çalışmalarımızı kolaylaştırmak için alınan anlık görüntüler, History geçmişi
gizle peletinin “Snapshot” komutu ile sağlanmaktadır. Snapshot komutu ile herhangi bir
görüntünün geçici bir kopyasını (anlık görüntüsünü) alınarak, görüntünün o hali üzerinde
çalışmamızı sağlar. Anlık görüntüler History paletinde listelenen durumlara benzerler, fakat
ek bazı avantajları vardır. Anlık görüntüler çalışma oturumu boyunca saklanır.
Çalışmalarınızda etkileri kolayca karşılaştırabilirsiniz. Örneğin, herhangi bir filtreyi
uygulamadan önce ve uyguladıktan sonraki birer anlık görüntüsünü alabilirsiniz. Ardından
ilk anlık görüntüyü seçip aynı filtreyi farklı ayarlarla deneyebilirsiniz. Böylece anlık
görüntüler arasında geçiş yaparak en beğendiğiniz ayarları bulabilirsiniz.

 Ekrana üzerinde çalışacağınız resmi File/Open’a tıklayarak açınız

 Menü çubuğundan Filter menüsüne girerek istediğiniz filitreyi uygulayın,
ardından history paletinden “create new snapshot” komutunu tıklayın.

Resim 2.33: History paneli

 Böylece her uygulamadan sonra anlık görüntü alabilir ve görüntüler üzerine
tıklayarak aralarında karşılaştırma yapabilirsiniz.

Orjinal görüntü

Filitre uyguland görüntüıktan sonraki

Resim 2.34: History panelinde Snapshot
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2.11. Seçerek yeniden düzenlemek için geçmişi dönme fırçası aracını
kullanmak

Geçmişe Dönme Fırçası aracı, belirtilmiş geçmiş durumdan veya anlık görüntüden
kaynak verileri kullanarak orijinal görüntüye dönmemizi sağlar. Farklı boyama stilleri ve
tolerans seçenekleriyle deneyerek, boyama dokusunun benzetimini farklı renkler ve sanatsal
stillerle yapabilirsiniz.

 Üzerinde filitreler uyguladığınız resim ekranınızda Araçlar çubuğundan
geçmişe dönme fırçasını “History Brush Tool”u işaretleyin.

Resim 2.35: Geçmişe dönme fırçası (History Brush Tool)

 Seçenekler çubuğundan fırçanın ucunu belirleyin.

Resim 2.36: Geçmişe dönme fırçası (History Brush Tool) seçenekler çubuğu
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 Fırçayı resim üzerinde sürüklediğinizde orijinal görüntünün ortaya çıktığını
göreceksiniz.

Resim 2.36: Geçmişe dönme fırçası (History Brush Tool) uygulaması

Brush tool boyama fırçasıyla yapılan uygulamalar da geçmişe dönme fırçası ile
üzerinde sürükleyerek orijinal haline dönmek mümkündür.
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UYGULAMA FAALİYETİ

Aşağıdaki işlemleri tamamladığınızda resim işleme programında piksel resim
üzerinde rötüş işlemleri yapmış olacaksınız.

Kullanılacak araç ve gereçler
 Bilgisayar

 Resim işleme programı

 Görseller

İşlem Basamakları Öneriler

 Piksel tabanlı programda görsel açınız.
 Atölye önlüğünüzü giymeyi

unutmayınız.

 Görseli kırpınız
 Görseli kullanacağınız alanı dikkate

alınız.

 Rötuş araçları ile resmi düzenleyiniz.
 Rötüşlama işlemine göre doğru araçları

seçiniz.

 Fazla ve gereksiz alanları temizleyerek,
filtre uygulamaları yapınız

 Dikkatli olunuz.

 Kayıt ediniz.
 Uygulama sırasında sorun ile

karşılaşırsanız öğretmeninizden yardım
alınız.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

Bu faaliyet sonunda kazandıklarınızı aşağıdaki soruları cevaplandırarak
ölçünüz.

ÖLÇME SORULARI

Aşağıdaki sorular çoktan seçmeli olarak hazırlanmıştır, doğru cevabı
seçenekler içinde işaretleyiniz.

1. Bir resmi doğrultmak ve kırpmak için hangi araç kullanılır?
A) Move
B) Crop
C) Magic Wand
D) Clone Stamp

2. Bir resimdeki renkleri değiştirmek için program menüsünden hangisi seçilir?
A) Image>Adjustment>Aoto Tone
B) Image>Mode>Replace Color
C) Image>Adjustment>Replace Color
D) Image>Aoto Contrast>Replace Color

3. Çevredeki görüntü içinde gözden kaybolmalarını sağlayarak kusurların giderilmesine
yardımcı olan araç hangisidir?.
A) Spot Healing Brush
B) Clone Stamp Tool
C) Eraser Tool
D) Eyedropper Tool

4. Resimdeki bazı karanlık noktaları temizlemek içinhangi araç kullanılır?
A) Custom Shape Tool
B) Burn Tool
C) Dimetrik perspektif
D) Clone Stamp Tool

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız ve doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevapladığınız sorularla ilgili öğrenme faaliyetlerini
tekrarlayınız.

ÖLÇME VE DEĞERLENDİRME
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UYGULAMALI TEST

Uygulama faaliyetindeki işlemi yapınız ve çalışmanızı aşağıdaki değerlendirme
ölçeğine göre değerlendiriniz.

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız becerileri
evet ve hayır kutucuklarına (X) işareti koyarak kontrol ediniz.

Değerlendirme Ölçütleri Evet Hayır

1. Bilgilerinizi gözden geçirdiniz mi?

2. Malzemeyi temin ettiniz mi?

3. Resim işleme programında piksel resmi açtınız mı?

4. Resmi kırpdınız mı?

5. Rötuş araçları ile resmi düzenlediniz mi?

6. Fazla ve gereksiz alanları temizleyerek filtre
uyguladınız mı?

7. Kayıt ettiniz mi?

8. Zamanı verimli kullanmaya dikkat ettiniz mi?

9. Çalışmanızdan memnun kaldınız mı?

DEĞERLENDİRME

Uygulama faaliyetinde kazandığınız davranışlarda işaretlediğiniz evetler kazandığınız
becerileri ortaya koyuyor. Hayırlarınız için ilgili faaliyetleri tekrarlayınız

Tamamı evet ise diğer öğrenme faaliyetine geçiniz.
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ÖĞRENME FAALİYETİ–3

Bu faaliyette verilecek bilgiler doğrultusunda, uygun ortam sağlandığında, gerekli
bitmap tabanlı programda resmin renk ayarlarını yapabilecektir.

 Günlük hayatta kullandığımız köşeli formlara sahip eşyaları sizden ortalama 2
metre mesafede karşınıza, zeminle farklı açılar oluşturacak şekilde yerleştirerek
görünüşlerini gözlemleyiniz. Aynı işlemi farklı bakış noktalarından yaparak
gözlemlerinizi not alınız.

 Görsel yayınlardan perspektif ile ilgili dokümanları araştırınız.

 Bulduğunuz perspektif resimler üzerinden ufuk çizgilerini, objelerin kaçış
noktalarını kalemle araştırarak bulmaya çalışınız.

3. RENK

3.1. Görüntü Modları

Piksel tabanlı programda resmin renk kombinasyonları rahatlıkla değiştirilir.
Kullanılan monitörün renkleri düzgün göstermesi çok önemlidir. Bunun için gerekirse
monitörü kalibre etmek gerekebilir. Görüntü modları içerisinde en sıklıkla kullanılan RGB,
CMYK ve Grayscale renk modlarıdır.

3.1.1. Grayscale

Piksel tabanlı programda grayscale Image modundaki fotoğraflar genelde 8 bit lik
resimlerdir. 8 bit grayscale bir resimde her bir pixel 0 (siyah)'dan 256 (beyaz)'a dek bir
tonlamaya sahiptir. Yani bir grayscale resim maksimum 256'lı bir gri tonlamaya sahiptir.
Grayscale bir resmi siyah beyaz bir resimle karıştırmamak gerekir. Siyah beyaz bir resim
sadece siyah ve beyaz tonlarından oluşurken grayscale bir resim, grinin pek çok tonunu
bünyesinde barındırır. Dijital görüntüleme sisteminde kullanılan Monochromatic (tek
renklilik) kelimesi de grayscale ile eş anlamlıdır.

Görüntünün RGB veya CMYK moddan Grayscale'a Dönüşüm işleminde bir gri tonu,
renk tonlarını (kırmızı, yeşil ve mavi) kapsar. Ardından her bir renk tonunun yoğunluğuna
göre gri tonları bu renklerin yerini alır. Burada değişim oranı, Photoshop tarafından insan
gözünün hassasiyeti dikkate alınarak belirlenir.

ÖĞRENME FAALİYETİ–3

AMAÇ

ARAŞTIRMA
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Resim 3.1: RGB moda bir bir resim

 Program menü çubuğundan Image menüsünden Mode Grayscale seçin

Resim 3.2: Grayscale modun seçilmesi

 Ekrana gelen pencere üzerinde “Discard” ı onaylayın

 Görüntü grayscale moda böylelikle dönüşür.
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3.1.2. CMYK

Geleneksel 4 renk baskı sistematiği Cyan (mavi), Magenta (kırmızı), Yellow (sarı) ve
Black (siyah) renklerinin karışımından oluşur. Diğer tüm renkler, bu mevcut dört rengin
karışımları yapılmış kombinasyonlarıyla oluşturulur. CMYK modunda kaydedilmiş bir
dosya açtığınız zaman program ekranın çalışma ve görüntüleme sistematiği RGB renk modu
olduğundan RGB'ye çevirerek karşımıza çıkarır. Yani ekranda baktığımız bir CMYK aslında
RGB'de bize sunulmaktadır, baskı sonucuyla ekranda gördüğümüz görüntü arasında farklılık
olması bu nedendendir.

Bu arada CMYK'da siyah rengin karşılığı olarak neden B (Black) kullanılmadığı akla
gelebilir. Bunun nedeni K'nın baskı terminolojisinde anahtar tabaka olarak adlandırılmasıdır.
Bu tabaka detayların en net göründüğü, diğer tabakalarda meydana gelebilecek bozukluğu
kapatan tabakadır. Siyahın bu kapatıcı olarak kullanılma durumu kullanılan kağıda,
mürekkebin cinsine ve kullanılan baskı teknolojisine göre değişiklikler gösterir. CMYK
mod'la elde edilen baskı, en yüksek kalitede kontrast ve renk yoğunluğu içeren görüntü
sonucunu verir. Tabi tekrar söylemek gerekirse ekran da görünenle baskı da elde edilen
sonuç arasında her zaman az ya da çok bir farklılık olur. Çünkü RGB ile CMYK farklı renk
limitlerine sahiptir.
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Resim 3.3: CMYK renk modu

3.1.3. RGB

Tüm renkli monitör, TV vb. görüntüleme cihazları RGB image modu kullanır ve
bunlarda tüm renkler kırmızı (Red), yeşil (Green) ve mavi (Blue) ışığın değişken
değerlerinden oluşur. Piksel tabanlı programda, resim dosyalarını RGB olarak kaydederken
üç tane 8 bit'lik grayscale dosya kullanır; biz de buna toplamda 24 bif lik resim deriz. Bu
dosyalar takribi 16 milyon rengi içerir ve daha fazlası fotografik kalitede resim olarak
adlandırılır.

RGB image mode'u fotografik resimlerle çalışılırken kullanılan temel mod'dur. Çoğu
tarayıcı da resimleri RGB olarak kaydeder; Eğer multimedia için resim üretimi yapılıyorsa
RGB format tercih edilir. Genellikle CMYK olan resim RGB moda dönüştürülür yada tam
tersi uygulanır.

Resim 3.4: RGB renk modu

Program menü çubundan Image menüsünden Mode RGB Color seçilerek dönüşüm
gerçekleştirilir.
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3.1.4. Lab Clour

RGB ve CMYK mod'larında şöyle ufak bir sorun vardır. RGB ve CMYK mod'ları
aslında tam olarak belli bir renk sistematiğini ifade edemezler. Örneğin; bir mağazada yan
yana duran TV'lere baktığınızda renk / ton farklılığından bunu görebilirsiniz. Ayrıca bir
matbaa da basılan herhangi bir işin baskı örneklerine baktığınızda yine bu farklılığı
yakalayabilirsiniz. Dolayısıyla RGB ve CMYK aygıta göre değişkenlik gösteren renk
modlarıdır.

Lab mod ise aygıttan bağımsız renk modudur. Lab modun temeli 1931'de kurulan
uluslararası renk, ışık kuruluşu The Commission Internationale de l'Eclairage (CIE)'m renk
sistematiğine dayanır. Lab bir rengi, kendisini meydana getiren komponentleriyle
tanımlamaz. Bunun yerine bir rengin görünümü neye benziyor prensibiyle hareket eder. Bu
aygıttan bağımsız renk sistematikleri mevcut renk yönetim sistemlerinin de kalbidir. Çünkü
ekran, renkli çıkış ve baskı arasındaki renk uyumluluğunu artırmakla görevlidirler. Lab mod
ile kaydedilmiş bir resim, belirlenmiş şartlar altında rengin neye benzediğini, seçtiğimiz
cihazda görünmek üzere nasıl karşımıza geldiğini, rengin oluşturulurken hangi RGB ya da
CMYK değerlerine ihtiyaç duyulacağını kararlaştırır. Programda, Lab modu CMYK ve RGB
mod'ları arasında değişim yaparken referans olarak kullanır. CMYK ve RGB'nin
kurulumlarından renk değerlerini alır ve bir hesapta toplar. Lab mode'da L lightness kanalını
yani ışığı temsil eder. a kanalı kırmızı ve yeşil renklerin yapısını (negatif değerler yeşili,
pozitif değerler kırmızıyı temsil eder) kontrol eder. b kanalı ise mavi ve sarı renklerin
yapısını (negatif değerler maviyi, pozitif değerler sarıyı) kontrol eder.

3.1.5. Indexted Clour

Grayscale bir resimdeki her bir pixel 8 bit'lik bir bilgiyle kaydedilmiştir. Yani dosya
256 farklı pixel tonunu kapsar. Fakat l'den 256'ya dek her bir ton grinin bir tonu olmak
zorunda da değildir. Indexed Color resim modu, 8 bit'lik 256 renkli resim dosyası üretme
metodu'dur.

Indexed color bitmap resimler, 24 bit paletten seçilmiş olan 256 rengi kullanırlar.
Pixeller bu paletdeki renkleri bu pixelin renk numarası 123, bunun ki 81 şeklinde referans
alırlar. Yani indexed color'da bir resim 256 farklı renkten oluşur. Bu durumda yüksek renk
tonlamasına sahip fotografik bir resimde, örneğin ışık / ton geçişlerinin olduğu yüksek renk
tonlamalı bölgelerde sınırlı renk paleti kullanımından dolayı bloklu geçişler meydana gelir.
Her ne kadar dithering ile bu sorun ciddi olarak azaltılmışsa da iyi bir göz bunu kolayca fark
eder.

Pixeller'deki açık - koyu ton ilişkisinin sınırlı olmasından dolayı bazı edit araçları
indexed color'da kullanılmaz. Sonuç olarak indexed color resimler genelde web grafiği
çalışmalarında kullanılır. Bu aşamada en uygun şey resmin öncelikle RGB olarak
hazırlanması (çünkü daha çok renk değerine sahiptir) ve son aşamada indexed color'a
dönüştürülerek renk kaybının en aza ve orijinalini olabilecek en iyi şekilde temsil eder hale
dönüştürülmesidir.
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3.2. Görüntü Düzenleme

3.2.1. Bright/Contrast

Brightness/Contrast, imajdaki parlaklığı ve kontrastı artırmak veya azaltmak için
kullanılır.

Resim 3.5: Brightness/Contrast panelinin açılması

Resim 3.5: Brightness/Contrast paneli

Resim 3.6: Brightness/Contrast uygulaması
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3.2.2. Curves

Curves Adjustment Tool, genel olarak resimlerdeki kontrastı ayarlamak için
kullandığım araçlardan bir tanesi fakat aynı zamanda resimdeki renk tonlamasını da
düzenleyebileceğimiz kullanışlı bir araç olarak tanımlanabilir. Çoğu zaman renk tonu
düzenleme işlemlerinde Color Balance Adjustment Tool yerine Curve Adjustment Tool
kullanmak daha pratik olur. Color Balance Adjustment Tool, resmi düzenlerken bize çok
kısıtlı seçenekler sunar, oysaki Curve Adjustment Tool ile resmin belirli bölgelerinde özel
renk ayarlamaları yapabiliriz.

 Program menü çubuğundan Image/Adjustments/Curves komutunu uygulayın.

Resim 3.7: Curves panelinin açılması

 Ekrana gelen paneldeki grafik üzerindeki 45 derecelik çizginin, tam ortasından
mause ile tıklayıp yukarı doğru sürüklediğinizde rengin giderek açıldığı görülür.
Tam tersi yönde hareket ettirildiğinde de koyulaşır.

Resim 3.8: Curves paneli
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 Curves uygulamasını kanallar üzerinden de yapmak uygun olabilir. Bunun için
curves penceresi açık iken Channel kutusundan Red i seçin. Artık sadece red
kanalı için düzenlemeler yapılır.

Resim 3.9: Curves panelinde Red kanalı

 Red kanalında iken grafik çizgisini yukarı ve aşağıya doğru hareket
ettirdiğimizde resim üzerinde red değerinin artması ve azalmasıyla görüntü
rengi değişmektedir. Aynı uygulamalar channel kutusundan Green ve Blue
seçilerek de yapılır.

Resim 3.10: Curves panelinde Red (kırmızı) arttırılması
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Resim 3.11: Curves panelinde Red (kırmızı) düşürülmesi

3.2.3. Levels

Resimdeki renklerin ton ayarlamalarını yapmamızı sağlar. Levels komutuna farklı
komutlarla ulaşabiliriz. Programın menü çubuğundan Image/Adjustments/Level komutuna
tıklayarak yada klavyeden ctrl+L tusuna basarak levels penceresinin ekrana getirebiliriz

Resim 3.12: Levels penceresinin açılması
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Ayrıca Layer penceresinin altındaki adjustment layer komutundan da level penceresini
açabiliriz.

Resim 3.13: Levels penceresinin açılması

Pencerede yer alan grafiğin altındaki ibreler siyah gri ve beyaz tonlarındadır. Her bir
ibreyi sağa sola sürüklendiğinizde sahip olduğu tonlamaya göre görüntü üzerinde renk
tonlaması yapar.

Resim 3.14: Levels penceresi
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3.2.4. Hue Saturation

Hue Saturation siyah-beyaz fotoğrafları renkli hale çevirmemize sağladığı gibi renkli
görüntülerde de renk değişikliği yapmamızı sağlar. Hue/Saturation; bir imajdaki belirli bir
renk aralığının hue (renk), saturation (doygunluk) ve lightness (parlaklık) değerlerini ya da
imajdaki bütün renklerin aynı anda değiştirilmesini mümkün kılar.

Resim 3.14: Hue/Saturation penceresinin açılması

Resim 3.15: Hue/Saturation uygulaması
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Resim 3.16: Hue/Saturation uygulaması

3.2.5. Clour Balance

Color Balance en profesyonel renk ayırımı için kullanılan araçlarından birisidir

Resim 3.17: Color Balance penceresinin açılması
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Resim 3.18: Color Balance uygulaması

3.2.6. Invert

Invert komutu imajdaki renklerin tersini oluşturur.

Resim 3.19: Invert komutu

Invert

Resim 3.20: Invert uygulaması
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3.2.7. Threshold
Threshold komutu Grayscale veya renkli bir imajı siyah-beyaz bir imaja dönüştürür.

Resim 3.21: Threshold penceresinin açılması

Resim 3.22: Threshold uygulaması
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3.2.8. Desaturate

Desaturate komutu renkli bir imajı Grayscale görünümüne dönüştürür, fakat imajın
renk modu değişmez.

Resim 3.23: Desaturate komutu

Resim 3.24: Desaturate uygulaması

Resminiz renkli bir resim ise desaturate komutu ile renkli olan resminizi gri tonlarına
çeviriniz. Bunun için Image > Adjustment > Desaturate komutunu kullanabilirsiniz.
Yukarıda renkli halini gördüğünüz resmin Desaturate(resmin gri tonlarını alması) işlemi
sonrasında görünümü.
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3.2.9. PSD Kayıt
PSD uzantılı dosyalar, fotoğraf düzenleme programına aittir. Layerlı (katmanları olan)

dosyaları kaydetme formatıdır. CMYK RGB Grayscale renk modlarını desteklemektedir

File > Save As yolunu kullanarak kaydetme mönüsünü açın. Buradan psd formatı
seçip, kaydet butonuna basın. Böylece resimdeki katmanları korumuş oluyoruz.

Resim 3.25: Save As (Farklı Kaydet) komutu

Resim 3.26: PSD kayıt
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3.2.10. TIFF, JPEG ve GIF Kayıt

3.2.10.1. Dosyayı TIFF formatında Kaydetme

TIFF tüm boyama, görüntü düzenleme ve sayfa mizanpajı uygulamaları tarafından
desteklenen, bitmap görüntü formatıdır. Tüm renk modları(cmyk, rgb, grayscale) ile
kaydedilir, ofset baskıya en uygun formattır.

 Dosya> Farklı Kaydet'i seçin, Format menüsünden TIFF'i seçin ve Kaydet'i
tıklatın.

1
2

3

Resim 3.27: TIFF kayıt

3.2.10.2. Dosyayı JPEG formatında kaydetme

CMYK, RGB ve gri tonlu görüntüleri JPEG formatında kaydetmek için Farklı Kaydet
komutunu kullanabilirsiniz. JPEG, dosya boyutunu verileri seçerek atama yoluyla sıkıştırır.
.JPEG 256dan fazla renk için uygun bir formattır. BMP olarak da kaydettiğimizde çok yer
kaplayacağı için JPEG idealdir.

Not: JPEG yalnızca, görüntü 8 Bit/Kanal olduğunda kullanılabilir (yalnızca 8
Bit/Kanal'ı destekler).

Orta kalitede bir JPEG'yi hızla kaydetmek için dosyaya JPEG Orta Olarak Kaydet
eylemini uygulayın. Bu eyleme, Eylemler paneli menüsünden Üretim'i seçerek
erişebilirsiniz.
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 Dosya > Farklı Kaydet'i seçin ve Format menüsünden JPEG 'i seçin.

Resim 3.28: JPEG kayıt

 JPEG Seçenekleri iletişim kutusunda istediğiniz seçenekleri belirleyin ve
Tamam'ı tıklatın.

Resim 3.29: JPEG kayıt seçenekleri
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3.2.10.3. Dosyayı GIF formatında kaydetme

GIF 256 renk destekleyen, görüntüleme hızı çok iyi olan sıkıştırma formatıdır. Daha
çok internet ortamında kullanılır. 8 Bit/Kanal'ı destekler.

 Dosya > Farklı Kaydet'i seçin ve Format menüsünden CompuServe GIF'yi
seçin.



Resim 3.30: GIF kayıt
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 RGB görüntüleri için dizinlenmiş”Indexed Color” iletişim kutusu görüntülenir,
Dönüştürme seçeneklerini belirleyin ve Tamam'ı tıklatın.

Resim 3.30: Indexed Color iletişim kutusu

 GIF dosyası için bir satır düzeni seçin ve Tamam'ı tıklatın.

Resim 3.31: GIF kayıt seçenekleri
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UYGULAMA FAALİYETİ

Aşağıdaki işlemleri tamamladığınızda resim işleme programında fotoğraf üzerinde
renk ayarlarını yapmış olacaksınız.

Kullanılacak araç ve gereçler
 Bilgisayar

 Resim işleme programı

 Görseller

İşlem Basamakları Öneriler

 Piksel tabanlı programda Bitmap Resmi
açınız.

 Atölye önlüğünüzü giymeyi
unutmayınız.

 Resmin modunu ayarlayınız
 Görseli kullanacağınız alanı dikkate

alınız.

 Açıklık Koyuluk ayarlamalarını yapınız  Ölçülere dikkat ediniz.

 Gri ton seviyesini ayarlayınız  Dikkatli olunuz.

 Renk ton seviyesini ayarlayınız

 Gri ton ve Renk doygunluk düzeylerini
ayarlayınız

 Kayıt ediniz.
 Uygulama sırasında sorun ile

karşılaşırsanız öğretmeninizden yardım
alınız.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

Bu faaliyet sonunda kazandıklarınızı aşağıdaki soruları cevaplandırarak
ölçünüz.

ÖLÇME SORULARI

Aşağıdaki sorular boşluk doldurmalı olarak hazırlanmıştır, boş bırakılan yere en
uygun cevabı yazınız.

1. …….. tüm boyama, görüntü düzenleme ve sayfa mizanpajı uygulamaları tarafından
desteklenen, bitmap görüntü formatıdır.

2. …….. …….. en profesyonel renk ayırımı için kullanılan araçlarından birisidir

3. Piksel tabanlı programda grayscale Image modundaki fotoğraflar genelde …. bit lik
resimlerdir.

4. Brightness/Contrast, imajdaki ……. ve ……. artırmak veya azaltmak için kullanılır.

5. …….. 256 renk destekleyen, görüntüleme hızı çok iyi olan sıkıştırma formatıdır.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız ve doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevapladığınız sorularla ilgili öğrenme faaliyetlerini
tekrarlayınız.

ÖLÇME VE DEĞERLENDİRME
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UYGULAMALI TEST

Resim işleme programında fotoğraf üzerinde renk ayarlarını yapınız ve
çalışmanızı aşağıdaki değerlendirme ölçütlerine göre değerlendiriniz.

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız becerileri evet
ve hayır kutucuklarına (X) işareti koyarak kontrol ediniz.

Değerlendirme Ölçütleri Evet Hayır

1. Bilgilerinizi gözden geçirdiniz mi?

2. Malzemeyi temin ettiniz mi?

3. Resim işleme programında bitmap resmi açtınız mı?

4. Resmin modunu ayarladınız mı?

5. Açıklık Koyuluk ayarlamalarını yaptınız mı?

6. Gri ton seviyesini ayarladınız mı?

7. Renk ton seviyesini ayarladınız mı?

8. Gri ton ve Renk doygunluk düzeylerini ayarladınız
mı?

9. Kayıt ettiniz mi?

10. Zamanı verimli kullanmaya dikkat ettiniz mi?

11. Çalışmanızdan memnun kaldınız mı?

DEĞERLENDİRME

Uygulama faaliyetinde kazandığınız davranışlarda işaretlediğiniz evetler kazandığınız
becerileri ortaya koyuyor. Hayırlarınız için ilgili faaliyetleri tekrarlayınız.

Tamamı evet ise modül değerlendirme faaliyetine geçiniz.
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MODÜL DEĞERLENDİRME
Modül sonunda kazandığınız yeterliği aşağıdaki uygulamayı yaparak

değerlendiriniz.

Resim işleme programında fotoğrafın boyut, rötuş ve renk ayarlarını yapınız
ve çalışmanızı aşağıdaki değerlendirme ölçütlerine göre değerlendiriniz.

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız becerileri evet
ve hayır kutucuklarına (X) işareti koyarak kontrol ediniz.

Değerlendirme Ölçütleri Evet Hayır

1. Bilgilerinizi gözden geçirdiniz mi?

2. Malzemeyi temin ettiniz mi?

3. Fotoğrafı resim işleme programında açtınız mı?

4. Çözünürlüğünü ayarladınız mı?

5. İstenilen boyuta getirdiniz mi?

6. Görselin istenmeyen bölümlerini silme/kesme işlemini yaptınız
mı?

7. Resmi kırpdınız mı?

8. Rötuş araçları ile resmi düzenlediniz mi?

9. Fazla ve gereksiz alanları temizleyerek filtre uyguladınız mı?

10. Resmin modunu ayarladınız mı?

11. Açıklık Koyuluk ayarlamalarını yaptınız mı?

12. Gri ton seviyesini ayarladınız mı?

13. Renk ton seviyesini ayarladınız mı?

14. Gri ton ve Renk doygunluk düzeylerini ayarladınız mı?

15. Kayıt ettiniz mi?

16. Zamanı verimli kullanmaya dikkat ettiniz mi?

17. Çalışmanızdan memnun kaldınız mı?

DEĞERLENDİRME

Uygulama faaliyetinde kazandığınız davranışlarda işaretlediğiniz evetler kazandığınız
becerileri ortaya koyuyor. Hayırlarınız için ilgili faaliyetleri tekrarlayınız.

Tamamı evet ise diğer modüle geçebilirsiniz

MODÜL DEĞERLENDİRME
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CEVAP ANAHTARLARI

ÖĞRENME FAALİYETİ–1’İN CEVAP ANAHTARI

1 "piksel"

2 Move Tool, “V”

3 Elliptical Marquee, “M”

4 Select/Inverse”

5 Navigator (Gezinti)

6 “History” (geçmiş)

ÖĞRENME FAALİYETİ–2’NİN CEVAP ANAHTARI

1 Crop

2
Image>Adjustment>Replace

Color

3 Spot Healing Brush

4 Clone Stamp Tool

ÖĞRENME FAALİYETİ–3’ÜN CEVAP ANAHTARI

1 TIFF

2 ColorBalance

3 8

4 Parlaklığı/kontrastı

5 GIF

CEVAP ANAHTARLARI
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